Agilent U7249A
MIPI M-PHY
Conformance Test
Application

Methods of Implementation
MIPI M-PHY Conformance Test Application — At A Glance

The Agilent U7249A MIPI M-PHY Conformance Test Application allows the testing of all MIPI devices with the Agilent Infiniium oscilloscope based on the MIPI Alliance Standard for M-PHY v1.00 specification. MIPI stands for Mobile Industry Processor Interface. The MIPI alliance is a collaboration of mobile industry leader with the objective to define and promote open standards for interfaces to mobile application processors.

The MIPI M-PHY Conformance Test Application:
• Lets you select individual or multiple tests to run.
• Lets you identify the device being tested and its configuration.
• Shows you how to make oscilloscope connections to the device under test.
• Automatically checks for proper oscilloscope configuration.
• Automatically sets up the oscilloscope for each test.
• Provides detailed information for each test that has been run, and lets you specify the thresholds at which marginal or critical warnings appear.
• Creates a printable HTML report of the tests that have been run.

NOTE
The tests performed by the MIPI M-PHY Conformance Test Application are intended to provide a quick check of the electrical health of the DUT. This testing is not a replacement for an exhaustive test validation plan.

Required Equipment and Software
In order to run the MIPI M-PHY Conformance Test Application, you need the following equipment and software:
• U7249A MIPI M-PHY Conformance Test Application software.
• The minimum version of Infiniium oscilloscope software (see the U7249A test application release notes).
• Differential probe amplifier, with the minimum bandwidth of 5 GHz.
• E2677A differential solder-in probe head, E2675A differential browser probe head, E2678A differential socket probe head, and E2669A differential kit which includes E2675A, E2677A, and E2678A are recommended.
• Keyboard, qty = 1, (provided with the Agilent Infiniium oscilloscope).
• Mouse, qty = 1, (provided with the Agilent Infiniium oscilloscope).
• Agilent also recommends using a second monitor to view the automated test application.
Below are the required licenses:

- U7249A MIPI M-PHY Conformance Test Application license.
- N5414A InfiniiScan software license.
In This Book

This manual describes the tests that are performed by the MIPI M-PHY Conformance Test Application in more detail.

- **Chapter 1**, “Installing the MIPI M-PHY Conformance Test Application” shows how to install and license the automated test application software (if it was purchased separately).

- **Chapter 2**, “Preparing to Take Measurements” shows how to start the MIPI M-PHY Conformance Test Application and gives a brief overview of how it is used.

- **Chapter 3**, “TX Signalling and Timing Electrical Tests” contains more information on the signalling and timing electrical tests for high-speed transmitters.

- **Chapter 4**, “Calibrating the Infiniium Oscilloscope and Probe” describes how to calibrate the oscilloscope in preparation for running the MIPI M-PHY automated tests.

- **Chapter 5**, “InfiniiMax Probing” describes the probe amplifier and probe head recommendations for MIPI M-PHY conformance testing.

See Also

- The MIPI M-PHY Conformance Test Application’s online help, which describes:
  - Starting the MIPI M-PHY conformance test application.
  - Creating or opening a test project.
  - Setting up the MIPI M-PHY test environment.
  - Selecting tests.
  - Configuring selected tests.
  - Defining compliance limits.
  - Connecting the oscilloscope to the DUT.
  - Running tests.
  - Automating the application.
  - Viewing test results.
  - Viewing/exporting/printing the HTML test report.
  - Saving test projects.
  - Installing/removing add-ins.
  - Controlling the application via a remote PC.
  - Using a second monitor.
Contents

MIPI M-PHY Conformance Test Application — At A Glance 3
Required Equipment and Software 3

In This Book 5
See Also 5

1 Installing the MIPI M-PHY Conformance Test Application
Installing the Software 12
Installing the License Key 12

2 Preparing to Take Measurements
Calibrating the Oscilloscope 14
Starting the MIPI M-PHY Conformance Test Application 15
Online Help Topics 17

3 TX Signalling and Timing Electrical Tests
Probing for High-Speed Clock Transmitter Electrical Tests 20
Test Procedure 20
HS-TX Differential DC Output Voltage Amplitude (\(V_{DIF\_DC\_xA\_xT\_TX}\)) 22
Test Definition Notes 22
Test References 22
PASS Condition 22
Measurement Algorithm 23
HS-TX Transmitter Eye Opening (\(T_{EYE\_TX}\)) 24
Test Definition Notes 24
Test References 24
PASS Condition 25
Measurement Algorithm 25
HS-TX Maximum Differential AC Output Voltage Amplitude (\(V_{DIF\_AC\_xA\_xT\_TX}\)) 26
Test Definition Notes 26
Test References 26
PASS Condition 27
Measurement Algorithm 27
<table>
<thead>
<tr>
<th>Test Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>HS-TX Common-Mode Output Voltage Amplitude ($V_{CM,xA_{TX}}$)</td>
<td>28</td>
</tr>
<tr>
<td>Test Definition Notes</td>
<td>28</td>
</tr>
<tr>
<td>Test References</td>
<td>28</td>
</tr>
<tr>
<td>PASS Condition</td>
<td>28</td>
</tr>
<tr>
<td>Measurement Algorithm</td>
<td>29</td>
</tr>
<tr>
<td>HS-TX 20%/80% Rise and Fall Times ($T_{R_{HS_{TX}}} \text{ and } T_{F_{HS_{TX}}}$)</td>
<td>30</td>
</tr>
<tr>
<td>Test Definition Notes</td>
<td>30</td>
</tr>
<tr>
<td>Test References</td>
<td>30</td>
</tr>
<tr>
<td>PASS Condition</td>
<td>31</td>
</tr>
<tr>
<td>Measurement Algorithm</td>
<td>31</td>
</tr>
<tr>
<td>HS-TX Lane-to-Lane Skew ($T_{L2L_{SKEW}<em>{HS</em>{TX}}}$)</td>
<td>32</td>
</tr>
<tr>
<td>Test Definition Notes</td>
<td>32</td>
</tr>
<tr>
<td>Test References</td>
<td>32</td>
</tr>
<tr>
<td>PASS Condition</td>
<td>32</td>
</tr>
<tr>
<td>Measurement Algorithm</td>
<td>32</td>
</tr>
<tr>
<td>HS-TX Slew Rate ($SR_{DIF_{TX}}$)</td>
<td>33</td>
</tr>
<tr>
<td>Test Definition Notes</td>
<td>33</td>
</tr>
<tr>
<td>Test References</td>
<td>33</td>
</tr>
<tr>
<td>PASS Condition</td>
<td>34</td>
</tr>
<tr>
<td>Measurement Algorithm</td>
<td>34</td>
</tr>
<tr>
<td>HS-TX Slew Rate State Monotonicity</td>
<td>35</td>
</tr>
<tr>
<td>Test References</td>
<td>35</td>
</tr>
<tr>
<td>PASS Condition</td>
<td>35</td>
</tr>
<tr>
<td>Measurement Algorithm</td>
<td>35</td>
</tr>
<tr>
<td>HS-TX Slew Rate State Resolution ($\Delta SR_{DIF_{TX}}$)</td>
<td>36</td>
</tr>
<tr>
<td>Test Definition Notes</td>
<td>36</td>
</tr>
<tr>
<td>Test References</td>
<td>36</td>
</tr>
<tr>
<td>PASS Condition</td>
<td>36</td>
</tr>
<tr>
<td>Measurement Algorithm</td>
<td>36</td>
</tr>
<tr>
<td>HS-TX Intra-Lane Output Skew ($T_{INTRA_{SKEW}_{TX}}$)</td>
<td>37</td>
</tr>
<tr>
<td>Test References</td>
<td>37</td>
</tr>
<tr>
<td>PASS Condition</td>
<td>37</td>
</tr>
<tr>
<td>Measurement Algorithm</td>
<td>38</td>
</tr>
<tr>
<td>HS-TX Transmitter Pulse Width ($T_{PULSE_{TX}}$)</td>
<td>39</td>
</tr>
<tr>
<td>Test References</td>
<td>39</td>
</tr>
<tr>
<td>PASS Condition</td>
<td>39</td>
</tr>
<tr>
<td>Measurement Algorithm</td>
<td>39</td>
</tr>
</tbody>
</table>
4 Calibrating the Infiniium Oscilloscope and Probe

Required Equipment for Oscilloscope Calibration 47

Internal Calibration 48

Required Equipment for Probe Calibration 51

Probe Calibration 52
  Connecting the Probe for Calibration 52
  Verifying the Connection 54
  Running the Probe Calibration and Deskew 56

Verifying the Probe Calibration 58

5 InfiniiMax Probing
1
Installing the MIPI M-PHY Conformance Test Application

Installing the Software  12
Installing the License Key  12

If you purchased the U7249A MIPI M-PHY Conformance Test Application separately, you need to install the software and license key.
Installing the MIPI M-PHY Conformance Test Application

Installing the Software

1. Make sure you have the minimum version of Infiniium oscilloscope software (see the U7249A test application release notes) by choosing Help>About Infiniium... from the main menu.


3. The link for MIPI M-PHY Conformance Test Application will appear. Double-click the link and follow the instructions to download and install the application software.

Installing the License Key

1. Request a license code from Agilent by following the instructions on the Entitlement Certificate.

   You will need the oscilloscope’s “Option ID Number”, which you can find in the Help>About Infiniium... dialog box.

2. After you receive your license code from Agilent, choose Utilities>Install Option License....

3. In the Install Option License dialog, enter your license code and click Install License.

4. Click OK in the dialog that tells you to restart the Infiniium oscilloscope application software to complete the license installation.

5. Click Close to close the Install Option License dialog.


7. Restart the Infiniium oscilloscope application software to complete the license installation.
2 Preparing to Take Measurements

Calibrating the Oscilloscope 14
Starting the MIPI M-PHY Conformance Test Application 15

Before running the MIPI M-PHY automated tests, you should calibrate the oscilloscope and probe. No test fixture is required for this MIPI M-PHY application. After the oscilloscope and probe have been calibrated, you are ready to start the MIPI M-PHY Conformance Test Application and perform the measurements.
Calibrating the Oscilloscope

If you have not already calibrated the oscilloscope and probe, see Chapter 4, “Calibrating the Infinium Oscilloscope and Probe”.

**NOTE**

If the ambient temperature changes more than 5 degrees Celsius from the calibration temperature, internal calibration should be performed again. The delta between the calibration temperature and the present operating temperature is shown in the Utilities>Calibration menu.

**NOTE**

If you switch cables between channels or other oscilloscopes, it is necessary to perform cable and probe calibration again. Agilent recommends that, once calibration is performed, you label the cables with the channel on which they were calibrated.
Starting the MIPI M-PHY Conformance Test Application

1. From the Infiniium oscilloscope’s main menu, choose Analyze > Automated Test Apps > U7249A MIPI M-PHY Test App.

![Image of MIPI M-PHY Conformance Test Application]

**Figure 1** The MIPI M-PHY Conformance Test Application
If the U7249A MIPI M-PHY Test App does not appear in the Automated Test Apps menu, the MIPI M-PHY Conformance Test Application has not been installed (see Chapter 1, “Installing the MIPI M-PHY Conformance Test Application”).

Figure 1 shows the MIPI M-PHY Conformance Test Application main window. The task flow pane, and the tabs in the main pane, show the steps you take in running the automated tests:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Up</td>
<td>Lets you identify and set up the test environment, including information about the device under test.</td>
</tr>
<tr>
<td>Select Tests</td>
<td>Lets you select the tests you want to run. The tests are organized hierarchically so you can select all tests in a group. After tests are run, status indicators show which tests have passed, failed, or not been run, and there are indicators for the test groups.</td>
</tr>
<tr>
<td>Configure</td>
<td>Lets you configure test parameters. This information appears in the HTML report.</td>
</tr>
<tr>
<td>Connect</td>
<td>Shows you how to connect the oscilloscope to the device under test for the tests to be run.</td>
</tr>
<tr>
<td>Run Tests</td>
<td>Starts the automated tests. If the connections to the device under test need to be changed while multiple tests are running, the tests pause, show you how to change the connection, and wait for you to confirm that the connections have been changed before continuing.</td>
</tr>
<tr>
<td>Automation</td>
<td>Lets you construct scripts of commands that drive execution of the application.</td>
</tr>
<tr>
<td>Results</td>
<td>Contains more detailed information about the tests that have been run. You can change the thresholds at which marginal or critical warnings appear.</td>
</tr>
<tr>
<td>HTML Report</td>
<td>Shows a compliance test report that can be printed.</td>
</tr>
</tbody>
</table>
Online Help Topics

For information on using the MIPI M-PHY Conformance Test Application, see its online help (which you can access by choosing Help>Contents... from the application’s main menu).

The MIPI M-PHY Conformance Test Application's online help describes:

• Starting the MIPI M-PHY Conformance Test Application.
• Creating or opening a test project.
• Setting up the MIPI M-PHY test environment.
• Selecting tests.
• Configuring selected tests.
• Defining compliance limits.
• Connecting the oscilloscope to the device under test (DUT).
• Running tests.
• Automating the application.
• Viewing test results.
• Viewing/exporting/printing the HTML test report.
• Saving test projects.
• Installing/removing add-ins.
• Controlling the application via a remote PC.
• Using a second monitor.
Preparing to Take Measurements
This section provides the Methods of Implementation (MOIs) for signalling and timing electrical tests for high-speed transmitters using an Agilent Infinium oscilloscope, InfiniiMax probes, and the MIPI M-PHY Conformance Test Application.

3 TX Signalling and Timing Electrical Tests

- Probing for High-Speed Clock Transmitter Electrical Tests
- HS-TX Differential DC Output Voltage Amplitude (VDIF\_DC\_xA\_xT\_TX)
- HS-TX Transmitter Eye Opening (TEYE\_TX)
- HS-TX Maximum Differential AC Output Voltage Amplitude (VDIF\_AC\_xA\_xT\_TX)
- HS-TX Common-Mode Output Voltage Amplitude (VCM\_xA\_TX)
- HS-TX 20%/80% Rise and Fall Times (TR\_HS\_TX and TF\_HS\_TX)
- HS-TX Lane-to-Lane Skew (TL2L\_SKEW\_HS\_TX)
- HS-TX Slew Rate (SRDIF\_TX)
- HS-TX Slew Rate State Monotonicity
- HS-TX Slew Rate State Resolution (DSRDIF\_TX)
- HS-TX Intra-Lane Output Skew (TINTRA\_SKEW\_TX)
- HS-TX Transmitter Pulse Width (TPULSE\_TX)
- HS-TX Total Jitter (TJTX)
- HS-TX Deterministic Jitter (DJTX)
- HS-TX Short-Term Total Jitter (STTJTX)
- HS-TX Short-Term Deterministic Jitter (STDJTX)
- HS-TX Common-Mode Power Spectral Magnitude Limit (PSDM\_TX)
- HS-TX Transmitter Frequency Offset (fOFFSET\_TX)
Probing for High-Speed Clock Transmitter Electrical Tests

When performing the HS Clock Tx tests, the MIPI M-PHY Conformance Test Application will prompt you to make the proper connections. The connections for the HS Clock Tx tests may look similar to the following diagram. Refer to the Connect tab in the MIPI M-PHY Conformance Test Application for the exact number of probe connections.

![Diagram of probe connections](image)

**Figure 2** Probing for High-Speed Clock Transmitter Electrical Tests

You can identify the channels used for each signal in the Configure tab of the MIPI M-PHY Conformance Test Application. (The channels shown in Figure 2 are just examples).

For more information on the probe amplifiers and probe heads, see Chapter 5, “InfiniiMax Probing,” starting on page 63.

**Test Procedure**

1. Start the automated test application as described in “Starting the MIPI M-PHY Conformance Test Application” on page 15.
2. In the MIPI M-PHY Conformance Test Application, click the Set Up tab.
3. Select the Test Group, and then enter the Device ID.
4. Click the Select Tests tab and check the tests you want to run. Check the parent node or group to check all the available tests within the group.
Figure 3  Selecting High-Speed Clock Transmitter Electrical Tests

5 Follow the MIPI M-PHY Conformance Test Application’s task flow to set up the configuration options, run the tests, and view the tests results.
HS-TX Differential DC Output Voltage Amplitude ($V_{\text{DIF\_DC\_xA\_xT\_TX}}$)

An M-TX drives a differential signal on the TXDP and TXDN PINs. The differential output voltage signal $V_{\text{DIF\_TX}(t)}$ is defined as the difference of the voltage signals $V_{\text{TXDP}(t)}$ and $V_{\text{TXDN}(t)}$. $V_{\text{DIF\_TX}}$ is defined as the amplitude of $V_{\text{DIF\_TX}(t)}$. $V_{\text{DIF\_TX}(t)}$ can be calculated from the following equation:

$$V_{\text{DIF\_TX}(t)} = V_{\text{TXDP}(t)} - V_{\text{TXDN}(t)}$$

The $V_{\text{DIF\_TX}(t)}$ measurements will be performed on the extended-length DIF-P and DIF-N states that are transmitted during the PREPARE and TAIL-OF-BURST states of an HS burst, respectively.

The purpose of this test is to verify that the $V_{\text{DIF\_TX}(t)}$ of the DUT HS-TX transmitter is within the conformance limits, for all combinations of supported Amplitudes, Terminations, Gears, and Lanes.

**Test Definition Notes**

**Table 1  DC Amplitude Parameter Summary**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Amplitude</th>
<th>Termination</th>
<th>Reference Load</th>
<th>Conformance Min</th>
<th>Conformance Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_{\text{DIF_DC_LA_RT_TX}}$</td>
<td>Large</td>
<td>Terminated</td>
<td>$R_{\text{REF_RT}}$</td>
<td>160 mV</td>
<td>240 mV</td>
</tr>
<tr>
<td>$V_{\text{DIF_DC_SA_RT_TX}}$</td>
<td>Small</td>
<td>Terminated</td>
<td>$R_{\text{REF_RT}}$</td>
<td>100 mV</td>
<td>130 mV</td>
</tr>
<tr>
<td>$V_{\text{DIF_DC_LA_NT_TX}}$</td>
<td>Large</td>
<td>Unterminated</td>
<td>$R_{\text{REF_NT}}$</td>
<td>320 mV</td>
<td>480 mV</td>
</tr>
<tr>
<td>$V_{\text{DIF_DC_SA_NT_TX}}$</td>
<td>Small</td>
<td>Unterminated</td>
<td>$R_{\text{REF_NT}}$</td>
<td>200 mV</td>
<td>260 mV</td>
</tr>
</tbody>
</table>

**Test References**

See Section 1.1.1 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*.

**PASS Condition**

The measured $V_{\text{DIF\_TX}(t)}$ value for the test signal should be within the conformance limit as specified in Table 1.1.1-1 of the *M-PHY Physical Layer Conformance Test Suite*. 
**Measurement Algorithm**

1. Select the desired test based on the HS-Gear, Termination mode, and Amplitude mode.

2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.

3. The scope will trigger for DIF-P and DIF-N.

4. Determine $V_{DIF\_TX(t)}$ by making a vertical MEAN histogram measurement on DIF-P and DIF-N respectively.
HS-TX Transmitter Eye Opening ($T_{EYE\_TX}$)

The purpose of this test is to verify that the DUT HS-TX transmitter meets the requirements for Transmitter Eye Opening ($T_{EYE\_TX}$), at the minimum Differential AC Output Voltage Amplitude ($V_{DIF\_AC\_XX\_TX}$), for all combinations of supported Amplitudes, Terminations, Gears, and Lanes.

The AC amplitude parameters limits are defined with the aid of a reference eye mask and are defined to be measured while the DUT is transmitting specific test patterns, namely CJTPAT and CRPAT. The eye diagram mask is shown in Figure 4. The Transmitter Eye Opening, $T_{EYE\_TX}$ value will be measured over the minimum $V_{DIF\_AC\_XX\_TX}$ conformance limit. The value of $T_{EYE\_TX}$ will be the horizontal width of the eye at the minimum $V_{DIF\_AC\_XX\_TX}$ limit.

![Figure 4  AC Amplitude Reference Mask](image)

**Test Definition Notes**

**Table 2  AC Amplitude Parameter Summary**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Amplitude</th>
<th>Termination</th>
<th>Reference Load</th>
<th>Conformance Min</th>
<th>Conformance Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_{DIF_AC_LA_RT_TX}$</td>
<td>Large</td>
<td>Terminated</td>
<td>$R_{REF_RT}$</td>
<td>140 mV</td>
<td>250 mV</td>
</tr>
<tr>
<td>$V_{DIF_AC_SA_RT_TX}$</td>
<td>Small</td>
<td>Terminated</td>
<td>$R_{REF_RT}$</td>
<td>80 mV</td>
<td>140 mV</td>
</tr>
<tr>
<td>$V_{DIF_AC_LA_NT_TX}$</td>
<td>Large</td>
<td>Unterminated</td>
<td>$R_{REF_NT}$</td>
<td>280 mV</td>
<td>500 mV</td>
</tr>
<tr>
<td>$V_{DIF_AC_SA_NT_TX}$</td>
<td>Small</td>
<td>Unterminated</td>
<td>$R_{REF_NT}$</td>
<td>160 mV</td>
<td>280 mV</td>
</tr>
</tbody>
</table>

**Test References**

See Section 1.1.2 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite.*
PASS Condition

The measured $T_{\text{EYE,TX}}$ value should be greater than 0.2 $\text{UI}_{\text{HS}}$ for the following parameters and their respective values.

- $V_{\text{DIF,AC,LA,RT,TX}} = 140 \text{ mV}$
- $V_{\text{DIF,AC,SA,RT,TX}} = 80 \text{ mV}$
- $V_{\text{DIF,AC,LA,NT,TX}} = 280 \text{ mV}$
- $V_{\text{DIF,AC,SA,NT,TX}} = 160 \text{ mV}$

Measurement Algorithm

1. Select the desired test based on the HS-Gear, Termination mode, and Amplitude mode.
2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
3. Trigger on the test pattern burst, CJTPAT or CRPAT.
4. Construct the eye diagram based on the differential signal of the test pattern.
5. Apply the TIE Filter with a bandpass of 1 MHz to data rate/2.
6. Load the mask, TEYE_TX.msk
7. Measure the eye width at $\pm V_{\text{DIF,AC,xx,xx,TX}}$ using the MIN and MAX histogram.
HS-TX Maximum Differential AC Output Voltage Amplitude
\((V_{\text{DIF AC}_xA_xT_TX})\)

The purpose of this test is to verify that the DUT HS-TX transmitter meets the requirements for the maximum Differential AC Output Voltage Amplitude \((V_{\text{DIF AC}_xA_xT_TX})\), for all combinations of supported Amplitudes, Terminations, Gears, and Lanes.

The AC parameter \(V_{\text{DIF AC}_\text{TX}}\) is defined for an M-TX which drives a test pattern into a reference load \(R_{\text{REF}}\), where the lower limit of \(V_{\text{DIF AC}_\text{TX}}\) is defined over the eye opening \(T_{\text{EYE}_\text{TX}}\). The upper limit of \(V_{\text{DIF AC}_\text{TX}}\) is defined as the maximum differential output voltage, when the M-TX drives a test pattern into a reference load \(R_{\text{REF}}\). An M-TX drives a differential AC output voltage signal which meets the specified limits of \(V_{\text{DIF AC}_\text{TX}}\).

In this test, an eye diagram will be constructed and the maximum \(V_{\text{DIF AC}_xA_xT_TX}\) value will be measured while the DUT is driving a CRPAT test pattern into the specified reference load \((R_{\text{REF RT}}\text{ or } R_{\text{REF NT}})\). Note that both the peak maximum and peak minimum values will be measured and reported separately.

### Test Definition Notes

**Table 3  AC Amplitude Parameter Summary**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Amplitude</th>
<th>Termination</th>
<th>Reference Load</th>
<th>Conformance Min</th>
<th>Conformance Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>(V_{\text{DIF AC}_\text{LA RT}_TX})</td>
<td>Large</td>
<td>Terminated</td>
<td>(R_{\text{REF RT}})</td>
<td>140 mV</td>
<td>250 mV</td>
</tr>
<tr>
<td>(V_{\text{DIF AC}_\text{SA RT}_TX})</td>
<td>Small</td>
<td>Terminated</td>
<td>(R_{\text{REF RT}})</td>
<td>80 mV</td>
<td>140 mV</td>
</tr>
<tr>
<td>(V_{\text{DIF AC}_\text{LA NT}_TX})</td>
<td>Large</td>
<td>Unterminated</td>
<td>(R_{\text{REF NT}})</td>
<td>280 mV</td>
<td>500 mV</td>
</tr>
<tr>
<td>(V_{\text{DIF AC}_\text{SA NT}_TX})</td>
<td>Small</td>
<td>Unterminated</td>
<td>(R_{\text{REF NT}})</td>
<td>160 mV</td>
<td>280 mV</td>
</tr>
</tbody>
</table>

### Test References

See Section 1.1.3 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*. 
PASS Condition

The peak maximum and peak minimum measured $V_{DIF\_AC\_xA\_xT\_TX}$ values should meet these limits.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Peak Minimum</th>
<th>Peak Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_{DIF_AC_LA_RT_TX}$</td>
<td>$&gt;-250 \text{ mV}$</td>
<td>$&lt;250 \text{ mV}$</td>
</tr>
<tr>
<td>$V_{DIF_AC_SA_RT_TX}$</td>
<td>$&gt;-140 \text{ mV}$</td>
<td>$&lt;140 \text{ mV}$</td>
</tr>
<tr>
<td>$V_{DIF_AC_LA_NT_TX}$</td>
<td>$&gt;-500 \text{ mV}$</td>
<td>$&lt;500 \text{ mV}$</td>
</tr>
<tr>
<td>$V_{DIF_AC_SA_NT_TX}$</td>
<td>$&gt;-280 \text{ mV}$</td>
<td>$&lt;280 \text{ mV}$</td>
</tr>
</tbody>
</table>

Measurement Algorithm

1. Select the desired test based on the HS-Gear, Termination mode, and Amplitude mode.
2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
3. Trigger on the test pattern burst, CJTPAT or CRPAT.
4. Construct the eye diagram based on the differential signal of the test patterns.
5. Apply the TIE Filter with a bandpass of 1 MHz to data rate/2.
6. Load mask, TEYE_TX.msk
7. Determine $V_{DIF\_AC\_TX}$ Top by making the MAX histogram measurement at the upper eye region.
8. Determine $V_{DIF\_AC\_TX}$ Bottom by making the MIN histogram measurement at the lower eye region.
HS-TX Common-Mode Output Voltage Amplitude \((V_{CM_{-}xA_{-}TX})\)

The purpose of this test is to verify that the Common-Mode Output Voltage Amplitude \((V_{CM_{-}xA_{-}TX})\) of the DUT HS-TX transmitter is within the conformance limits, for all combinations of supported Amplitudes, Gears, and Lanes.

The common-mode output voltage signal \(V_{CM_{-}TX(t)}\) is defined as the arithmetic mean value of the signal voltages \(V_{TXDP(t)}\) and \(V_{TXDN(t)}\) when the M-TX drives a test pattern into a reference load \(R_{REF}\). \(V_{CM_{-}TX}\) is defined as the amplitude of \(V_{CM_{-}TX(t)}\). An M-TX drives a common-mode output voltage signal which meets the specified limits of \(V_{CM_{-}TX}\).

In this test, the measurement is performed on the extended-length DIF-P and DIF-N states that are transmitted during the PREPARE and TAIL-OF-BURST states of an HS burst, respectively. The \(V_{CM_{-}xA_{-}TX}\) value is measured as the mean value of \(V_{CM_{-}TX(t)}\) while the DUT is transmitting the extended DIF-P/DIF-N state.

**Test Definition Notes**

**Table 4**  Common-Mode Amplitude Parameter Summary

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Amplitude</th>
<th>Termination</th>
<th>Reference Load</th>
<th>Conformance Min</th>
<th>Conformance Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>(V_{CM_{-}LA_{-}TX})</td>
<td>Large</td>
<td>Terminated</td>
<td>(R_{REF_RT})</td>
<td>160 mV</td>
<td>260 mV</td>
</tr>
<tr>
<td>(V_{CM_{-}SA_{-}TX})</td>
<td>Small</td>
<td>Terminated</td>
<td>(R_{REF_RT})</td>
<td>80 mV</td>
<td>190 mV</td>
</tr>
</tbody>
</table>

**Test References**

See Section 1.1.4 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*.

**PASS Condition**

For both DIF-P and DIF-N states, the measured values should be as follows:

- the \(V_{CM\_LA\_TX}\) value should be between 160 mV and 260 mV
- the \(V_{CM\_SA\_TX}\) value should be between 80 mV and 190 mV
Measurement Algorithm

1. Select the desired test based on the HS-Gear, Termination mode, and Amplitude mode.

2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.

3. The scope will trigger for DIF-P and DIF-N.

4. Use the Common-Mode Function on the scope to acquire the common-mode signal in the DIF-P and DIF-N regions.

5. Determine $V_{CM_{TX}}$ by making vertical histogram measurements on DIF-P and DIF-N respectively.
HS-TX 20%/80% Rise and Fall Times (\(T_{R_{\text{HS\_TX}}}\) and \(T_{F_{\text{HS\_TX}}}\))

The purpose of this test is to verify that the 20%/80% Rise and Fall Times (\(T_{R_{\text{HS\_TX}}}\) and \(T_{F_{\text{HS\_TX}}}\)) of the DUT HS-TX transmitter are within the conformance limits, for all combinations of supported Amplitudes, Terminations, and Lanes, for HS-G1.

The HS-TX rise and fall times, \(T_{R_{\text{HS\_TX}}}\) and \(T_{F_{\text{HS\_TX}}}\) respectively, are defined as the transition times between the 20% and 80% signal levels of the differential HS-TX output signal, whose amplitude is defined by \(V_{\text{DIF\_DC\_TX}}\), when driving a repetitive D30.3 symbol sequence into a reference load \(R_{\text{REF}}\). The minimum limits of \(T_{R_{\text{HS\_TX}}}\) and \(T_{F_{\text{HS\_TX}}}\) should be met by an HS-TX when operated in HS-GEAR1. The maximum transition times are bounded by the HS-TX eye diagram specification.

In this test, the DUT will be configured to transmit a test pattern, which contains sections of repeating D30.3, into the reference terminations \(R_{\text{REF\_RT}}\) and \(R_{\text{REF\_NT}}\). The rise and fall times will be measured on an averaged D30.3 reference waveform using the reference amplitudes defined by the measured \(V_{\text{DIF\_DC\_TX\_TX}}\) values obtained in the HS-TX Differential DC Output Voltage Amplitude test. The measurement will be performed for all combinations of supported Amplitudes, Terminations, and Lanes, for HS-G1 (CTS 0.65 only supports testing for HS-G1 for this test).

**Test Definition Notes**

**Table 5** M-PHY Specification 1.00, Section 5.1.2.11, Table 15

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>HS-TX Timing</strong></td>
</tr>
<tr>
<td>(T_{F_{\text{HS_TX}}})</td>
<td>0.1</td>
<td></td>
<td>(\mu\text{I}_{\text{HS}})</td>
<td>Fall time. Defined for (R_{\text{REF_RT}}) and (R_{\text{REF_NT}}) and test pattern. See M-PHY Specification 1.00, Section 5.1.2.1.</td>
</tr>
<tr>
<td>(T_{R_{\text{HS_TX}}})</td>
<td>0.1</td>
<td></td>
<td>(\mu\text{I}_{\text{HS}})</td>
<td>Rise time. Defined for (R_{\text{REF_RT}}) and (R_{\text{REF_NT}}) and test pattern. See M-PHY Specification 1.00, Section 5.1.2.1.</td>
</tr>
</tbody>
</table>

**Test References**

See Section 1.1.5 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*.
PASS Condition

The 20%/80% Rise and Fall Times values should be as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR_HS_LA_RT_TX</td>
<td>&gt; 0.1* UI_HS</td>
</tr>
<tr>
<td>TF_HS_LA_RT_TX</td>
<td></td>
</tr>
<tr>
<td>TR_HS-SA_RT_TX</td>
<td>&gt; 0.1* UI_HS</td>
</tr>
<tr>
<td>TF_HS-SA_RT_TX</td>
<td></td>
</tr>
<tr>
<td>TR_HS.LA_NT_TX</td>
<td>&gt; 0.1* UI_HS</td>
</tr>
<tr>
<td>TF_HS.LA_NT_TX</td>
<td></td>
</tr>
<tr>
<td>TR_HS_SA_NT_TX</td>
<td>&gt; 0.1* UI_HS</td>
</tr>
<tr>
<td>TF_HS_SA_NT_TX</td>
<td></td>
</tr>
</tbody>
</table>

Measurement Algorithm

This test is yet to be implemented.
HS-TX Lane-to-Lane Skew (TL2L_SKEW_HS_TX)

The purpose of this test is to verify that the Lane-to-Lane Skew (TL2L_SKEW_HS_TX) of the DUT HS-TX transmitter meets the specified conformance limits.

The HS-TX LANE-TO-LANE Skew, TL2L_SKEW_HS_TX, is defined as the time between the zero crossings of the differential output signals V_DIF_TX(t) of any two HS-TXs in one SUB-LINK, when both HS-TX drive a test pattern into identical reference loads R_{REF}.

In this test, the measurement is performed while the DUT is driving a test pattern in terminated mode into the R_{REF_RT} reference load. The skew will be reported as the mean timing error between the two Lanes, based on the zero-crossing times.

Test Definition Notes

Table 6  Protocol-Specific Lane-to-Lane Skew Requirements Summary

<table>
<thead>
<tr>
<th>Specification</th>
<th>SYS</th>
<th>PWM</th>
<th>HS-G1</th>
<th>HS-G2</th>
<th>HS-G3</th>
</tr>
</thead>
<tbody>
<tr>
<td>UniPro</td>
<td>n/a</td>
<td>40 ns</td>
<td>16 ns</td>
<td>8 ns</td>
<td>4 ns</td>
</tr>
<tr>
<td>DigRFv4</td>
<td>*</td>
<td>n/a</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>

Test References

See Section 1.1.6 in version 0.65 of the M-PHY Physical Layer Conformance Test Suite.

PASS Condition

The HS Lane-to-Lane Skew (TL2L_SKEW_HS_TX) value should be less than the HS limits specified in Table 6 or Table 1.1.6-1 in the M-PHY Physical Layer Conformance Test Suite.

Measurement Algorithm

This test is yet to be implemented.
HS-TX Slew Rate (SR\textsubscript{DIF\_TX})

The purpose of this test to verify that the Slew Rate (SR\textsubscript{DIF\_TX}) of the DUT HS-TX transmitter is within the conformance limits for Small and Large Amplitudes, in Terminated mode, for HS-G1, and for all Lanes.

The Slew Rate, SR\textsubscript{DIF\_TX} is defined as the ratio $\Delta V/\Delta T$, where $\Delta V$ is the absolute value of the voltage difference of the differential HS-TX output signal voltage measured at the 20% and 80% levels of $V\text{DIF\_DC\_SA\_RT\_TX}$, and $\Delta T$ is the corresponding time difference when the HS-TX drives a reference load $R_{REF}$ with Small Amplitude. The specification limits of SR\textsubscript{DIF\_TX} should be met by a HS-TX that supports slew rate control and operates in HS-G1.

In this test, the measurement will be made for the Large and Small Amplitude cases using the values of $V\text{DIF\_DC\_SA\_RT\_TX}$ and $V\text{DIF\_DC\_LA\_RT\_TX}$ measured in the HS-TX Differential DC Output Voltage Amplitude test. From these reference amplitudes, the 20% and 80% crossing times will be determined, and the dV/dt values will be computed for each edge in the test pattern.

**Test Definition Notes**

**Table 7  Slew Rate Requirements Summary**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Amplitude</th>
<th>Termination</th>
<th>Reference Load</th>
<th>Conformance Min</th>
<th>Conformance Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>$SR_{DIF_SA_RT_TX}[MAX]$</td>
<td>Small</td>
<td>Terminated</td>
<td>$R_{REF_RT}$</td>
<td>0.9 V/ns</td>
<td>n/a</td>
</tr>
<tr>
<td>$SR_{DIF_SA_RT_TX}[MIN]$</td>
<td>Small</td>
<td>Terminated</td>
<td>$R_{REF_RT}$</td>
<td>n/a</td>
<td>0.35 V/ns</td>
</tr>
<tr>
<td>$SR_{DIF_LA_RT_TX}[MAX]$</td>
<td>Large</td>
<td>Terminated</td>
<td>$R_{REF_RT}$</td>
<td>1.665 V/ns</td>
<td>n/a</td>
</tr>
<tr>
<td>$SR_{DIF_LA_RT_TX}[MIN]$</td>
<td>Large</td>
<td>Terminated</td>
<td>$R_{REF_RT}$</td>
<td>n/a</td>
<td>0.6475 V/ns</td>
</tr>
</tbody>
</table>

**Test References**

See Section 1.1.7 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*. 
PASS Condition

The slew rate values should meet the following limits.

- $\text{SR}_{\text{DIFF_SA_RT_TX}}[\text{MAX}]$ is greater than 0.90 V/ns
- $\text{SR}_{\text{DIFF_SA_RT_TX}}[\text{MIN}]$ is less than 0.35 V/ns
- $\text{SR}_{\text{DIFF_LA_RT_TX}}[\text{MAX}]$ is greater than 1.665 V/ns
- $\text{SR}_{\text{DIFF_LA_RT_TX}}[\text{MIN}]$ is less than 0.6475 V/ns

Measurement Algorithm

1. Select the desired test based on the HS-Gear, Termination mode, and Amplitude mode.
2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
3. The scope will trigger on the test pattern burst.
4. The scope will make the MIN and MAX rise time measurement on the test pattern differential signal.
5. The scope will make the MIN and MAX fall time measurement on the test pattern differential signal.
6. Calculate the slew rate based on 80%–20% from VDIF-P and VDIF-N.
HS-TX Slew Rate State Monotonicity

The purpose of this test is to verify that the N Slew Rate control states of the DUT HS-TX transmitter support monotonically decreasing Slew Rate settings, for Small and Large Amplitudes, in Terminated mode, for HS-G1, and for all Lanes.

The slew rate should be monotonically decreasing when stepping from faster to slower slew rate states, i.e., SR\textsubscript{DIF\_TX\_i} is larger than SR\textsubscript{DIF\_TX\_i+1}, where i is in the range of 1 to N–1. It should be monotonically increasing when stepping from slower to faster slew rate states. The tolerance of a slew rate state is not defined. Different slew rate states may overlap, but they should not violate the monotonicity requirement.

In this test, the N reported SR\textsubscript{DIF\_SA\_RT\_TX} and SR\textsubscript{DIF\_LA\_RT\_TX} values from the HS-TX Slew Rate test will be checked, in order to verify that the reported Slew Rate values are monotonically decreasing, with the fastest Slew Rate being reported for SR\textsubscript{DIF\_SA\_RT\_TX\_1}, and the slowest being reported for SR\textsubscript{DIF\_SA\_RT\_TX\_N}. If this is the case for both the Large and Small Amplitude cases, the DUT will be considered conformant.

Test References

See Section 1.1.8 in version 0.65 of the M-PHY Physical Layer Conformance Test Suite.

PASS Condition

For the Small Amplitude case, verify that the SR\textsubscript{DIF\_SA\_RT\_TX} results are monotonically decreasing, with SR\textsubscript{DIF\_SA\_RT\_TX\_1} having the largest value.

For the Large Amplitude case, verify that the SR\textsubscript{DIF\_LA\_RT\_TX} results are monotonically decreasing, with SR\textsubscript{DIF\_LA\_RT\_TX\_1} having the largest value.

Measurement Algorithm

This test is yet to be implemented.
HS-TX Slew Rate State Resolution ($\Delta SR_{DIF\_TX}$)

The purpose of this test is to verify that the Slew Rate State Resolution ($\Delta SR_{DIF\_TX}$) of the DUT HS-TX Slew Rate control satisfies the conformance requirements.

$\Delta SR_{DIF\_TX}$ can be calculated using the following equation:

$$\Delta SR_{DIF\_TX} = \frac{SR_{DIF\_TX[i]} - SR_{DIF\_TX[i+1]}}{SR_{DIF\_TX[i+1]}}$$

In this test, the Slew Rate Resolution will be calculated using the reported $SR_{DIF\_SA\_RT\_TX}$ and $SR_{DIF\_LA\_RT\_TX}$ values obtained in the HS-TX Slew Rate test, using the formula shown above.

**Test Definition Notes**

Table 8  M-PHY Specification 1.00, Section 5.1.2.11, Table 15

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Values</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\Delta SR_{DIF_TX}$</td>
<td>1</td>
<td>30%</td>
<td>Resolution of slew rate states. Defined in HS-GEAR1 for $V_{DIF_DC_SA_RT_TX}$. See M-PHY Specification 1.00, Section 5.1.2.2.</td>
</tr>
</tbody>
</table>

**Test References**

See Section 1.1.9 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*.

**PASS Condition**

The $\Delta SR_{DIF\_SA\_RT\_TX}$ and $\Delta SR_{DIF\_LA\_RT\_TX}$ values should be greater than 1% and less than 30%.

**Measurement Algorithm**

This test is yet to be implemented.
**HS-TX Intra-Lane Output Skew ($T_{INTRA\_SKEW\_TX}$)**

The purpose of this test to verify that the Intra-Lane Output Skew ($T_{INTRA\_SKEW\_TX}$) of the DUT HS-TX transmitter is within the conformance limits, for all combinations of supported Amplitudes, Terminations, Gears, and Lanes.

The figure below is extracted from the M-PHY Specification 1.00.

![Figure 5](image.png)

**Figure 5**  Impact of Signal Skew on Common-Mode

In this test, the $T_{INTRA\_SKEW\_TX}$ of the DUT will be measured while the DUT is driving a CRPAT pattern into the specified reference load ($R_{REF\_RT}$ or $R_{REF\_NT}$). The final reported result will be taken as the mean skew value computed over all edges. The measurement will be performed for both the Large and Small Amplitudes, terminated and unterminated cases, and for all Lanes, at HS-G1.

**Test References**

See Section 1.1.10 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*, and Table 15 in Section 5.1.2.11 of the *M-PHY Specification 1.00*.

**PASS Condition**

The intra-lane output skew values should meet the following limits.

- $T_{INTRA\_SKEW\_LA\_RT\_TX}$ is between $-0.06*U_{IH}\_S$ and $0.06*U_{IH}\_S$
- $T_{INTRA\_SKEW\_SA\_RT\_TX}$ is between $-0.06*U_{IH}\_S$ and $0.06*U_{IH}\_S$
- $T_{INTRA\_SKEW\_LA\_NT\_TX}$ is between $-0.06*U_{IH}\_S$ and $0.06*U_{IH}\_S$
- $T_{INTRA\_SKEW\_SA\_NT\_TX}$ is between $-0.06*U_{IH}\_S$ and $0.06*U_{IH}\_S$
Measurement Algorithm

1 Select the desired test based on HS-Gear, Termination mode, and Amplitude mode.
2 Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
3 The scope will trigger on the test pattern burst.
4 The scope will produce the differential of TXDP and TXDN.
5 The scope will measure the average common-mode voltage of the differential signal.
6 The scope will form an eye diagram of TXDP and TXDN.
7 The scope will make a histogram measurement at the left crossing of the eye at the average common-mode voltage.
8 The $T_{\text{INTRA}_SKEW_{TX}}$ is determined by the difference of MAX and MIN of the histogram results.
HS-TX Transmitter Pulse Width ($T_{PULSE\_TX}$)

The purpose of this test to verify that the pulse width ($T_{PULSE\_TX}$) of the DUT HS-TX transmitter is within the conformance limits, for all combinations of supported Amplitudes, Terminations, and Lanes, at HS-G1.

In this test, the transmitter pulse width of the DUT will be measured while the DUT is driving a CRPAT test pattern into the $R_{REF\_RT}$ and $R_{REF\_NT}$ reference loads. The measurement will be performed for all Lanes, at HS-G1.

Test References

See Section 1.1.11 in version 0.65 of the M-PHY Physical Layer Conformance Test Suite, and Table 15 in Section 5.1.2.6 of the M-PHY Specification 1.00.

PASS Condition

The pulse width values should meet the following limits.

- $T_{PULSE\_LA\_RT\_TX}$ is greater than 0.9*UI$_{HS}$
- $T_{PULSE\_SA\_RT\_TX}$ is greater than 0.9*UI$_{HS}$
- $T_{PULSE\_LA\_NT\_TX}$ is greater than 0.9*UI$_{HS}$
- $T_{PULSE\_SA\_NT\_TX}$ is greater than 0.9*UI$_{HS}$

Measurement Algorithm

1. Select the desired test based on HS-Gear, Termination mode, and Amplitude mode.
2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
3. The scope will trigger on the test pattern burst.
4. The scope will produce the differential of TXDP and TXDN.
5. The scope will measure the minimum positive and negative pulse width in the differential test pattern signal.
HS-TX Total Jitter ($TJ_{TX}$)

The purpose of this test to verify that the Total Jitter ($TJ_{TX}$) of the DUT HS-TX transmitter is within the conformance limits, for all combinations of supported Amplitudes, Terminations, and Lanes, at HS-G1.

In this test, the total jitter of the DUT will be measured while the DUT is driving a CRPAT test pattern into the $R_{REF\_RT}$ and $R_{REF\_NT}$ reference loads. The jitter will be filtered with the $H_{TX}(f)$ bandpass filter having a range of 1 MHz to $1/(2*U_{I\_HS})$. Also, a constant-frequency (i.e., linear fit) CDR will be used to recover a reference clock from the data stream.

Test References

See Section 1.1.12 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*, and Section 5.1.2.7 of the *M-PHY Specification 1.00*.

PASS Condition

The total jitter values should meet the following limits.

- $TJ_{LA\_RT\_TX}$ is less than $0.32*U_{I\_HS}$
- $TJ_{SA\_RT\_TX}$ is less than $0.32*U_{I\_HS}$
- $TJ_{LA\_NT\_TX}$ is less than $0.32*U_{I\_HS}$
- $TJ_{SA\_NT\_TX}$ is less than $0.32*U_{I\_HS}$

Measurement Algorithm

1. Select the desired test based on HS-Gear, Termination mode, and Amplitude mode.
2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
3. The scope will trigger on the test pattern burst.
4. The scope will produce the differential of TXDP and TXDN.
5. The TIE filter is applied with a bandpass of 1 MHz to $1/(2*U_{I\_HS})$.
6. The scope will carry out the RJDJ Jitter analysis to measure the jitter parameters.
7. The Total Jitter (TJ) measurement is part of the jitter analysis.
HS-TX Deterministic Jitter (DJ_{TX})

The purpose of this test to verify that the Deterministic Jitter (DJ_{TX}) of the DUT HS-TX transmitter is within the conformance limits, for all combinations of supported Amplitudes, Terminations, and Lanes, at HS-G1.

In this test, the deterministic jitter of the DUT will be measured while the DUT is driving a CRPAT test pattern into the R_{REF,RT} and R_{REF,NT} reference loads. The jitter will be filtered with the H_{TX}(f) bandpass filter having a range of 1 MHz to 1/(2*U_{I_{HS}}). Also, a constant-frequency (i.e., linear fit) CDR will be used to recover a reference clock from the data stream.

Test References

See Section 1.1.13 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*, and Section 5.1.2.7 of the *M-PHY Specification 1.00*.

PASS Condition

The deterministic jitter values should meet the following limits.

- DJ_{LA,RT,TX} is less than 0.15*U_{I_{HS}}
- DJ_{SA,RT,TX} is less than 0.15*U_{I_{HS}}
- DJ_{LA,NT,TX} is less than 0.15*U_{I_{HS}}
- DJ_{SA,NT,TX} is less than 0.15*U_{I_{HS}}

Measurement Algorithm

- Select the desired test based on HS-Gear, Termination mode, and Amplitude mode.
- Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
- The scope will trigger on the test pattern burst.
- The scope will produce the differential of TXDP and TXDN.
- The TIE filter is applied with a bandpass of 1 MHz to 1/(2*U_{I_{HS}}).
- The scope will carry out the RJDJ Jitter analysis to measure the jitter parameters.
- The Deterministic Jitter (DJ) measurement is part of the jitter analysis.
HS-TX Short-Term Total Jitter (STTJ<sub>TX</sub>)

The purpose of this test to verify that the Short-Term Total Jitter (STTJ<sub>TX</sub>) of the DUT HS-TX transmitter is within the conformance limits, for all combinations of supported Amplitudes, Termination, and Lanes, at HS-G1.

In this test, the Short-Term Total Jitter of the DUT will be measured while the DUT is driving a CRPAT test pattern into the R<sub>REF_RT</sub> and R<sub>REF_NT</sub> reference loads. The jitter will be filtered with the HS<sub>TJ_TX(T)</sub> bandpass filter having a range of 1/(30*UI<sub>HS</sub>) to 1/(2*UI<sub>HS</sub>). Also, a constant-frequency (i.e., linear fit) CDR will be used to recover a reference clock from the data stream.

Test References

See Section 1.1.14 in version 0.65 of the M-PHY Physical Layer Conformance Test Suite, and Section 5.1.2.7 of the M-PHY Specification 1.00.

PASS Condition

The short-term total jitter values should meet the following limits.

- STTJ<sub>LA_RT_TX</sub> is less than 0.20*UI<sub>HS</sub>
- STTJ<sub>SA_RT_TX</sub> is less than 0.20*UI<sub>HS</sub>
- STTJ<sub>LA_NT_TX</sub> is less than 0.20*UI<sub>HS</sub>
- STTJ<sub>SA_NT_TX</sub> is less than 0.20*UI<sub>HS</sub>

Measurement Algorithm

1. Select the desired test based on HS-Gear, Termination mode, and Amplitude mode.
2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
3. The scope will trigger on the test pattern burst.
4. The scope will produce the differential of TXDP and TXDN.
5. The TIE filter is applied with a bandpass of 1/(30*UI<sub>HS</sub>) to 1/(2*UI<sub>HS</sub>.
6. The scope will carry out the RJDJ Jitter analysis to measure the jitter parameters.
7. The Short-Term Total Jitter (TJ) measurement is part of the jitter analysis.
HS-TX Short-Term Deterministic Jitter (STDJ_{TX})

The purpose of this test is to verify that the Short-Term Deterministic Jitter (STDJ_{TX}) of the DUT HS-TX transmitter is within the conformance limits, for all combinations of supported Amplitudes, Terminations, and Lanes, at HS-G1.

In this test, the Short-Term Deterministic Jitter of the DUT will be measured while the DUT is driving a CRPAT test pattern into the R_{REF_RT} and R_{REF_NT} reference loads. The jitter will be filtered with the HSTJ_{TX(f)} bandpass filter having a range of 1/(30*UI_{HS}) to 1/(2*UI_{HS}). Also, a constant-frequency (i.e., linear fit) CDR will be used to recover a reference clock from the data stream.

Test References

See Section 1.1.15 in version 0.65 of the M-PHY Physical Layer Conformance Test Suite, and Section 5.1.2.7 of the M-PHY Specification 1.00.

PASS Condition

The short-term deterministic jitter values should meet the following limits.

- STDJ_{LA_RT_TX} is less than 0.10*UI_{HS}
- STDJ_{SA_RT_TX} is less than 0.10*UI_{HS}
- STDJ_{LA_NT_TX} is less than 0.10*UI_{HS}
- STDJ_{SA_NT_TX} is less than 0.10*UI_{HS}

Measurement Algorithm

1. Select the desired test based on HS-Gear, Termination mode, and Amplitude mode.
2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
3. The scope will trigger on the test pattern burst.
4. The scope will produce the differential of TXDP and TXDN.
5. The TIE filter is applied with a bandpass of 1/(30*UI_{HS}) to 1/(2*UI_{HS}).
6. The scope will carry out the RJDJ Jitter analysis to measure the jitter parameters.
7. The Short-Term Deterministic Jitter (DJ) measurement is part of the jitter analysis.
HS-TX Common-Mode Power Spectral Magnitude Limit ($PSD_{CM\_TX}$)

The purpose of this test to verify that the Common-Mode Power Spectral Magnitude of the DUT HS-TX transmitter is below the conformance limit.

Test References

See Section 1.1.16 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*, and Section 5.1.2.9.2 of the *M-PHY Specification 1.00*.

PASS Condition

The common-mode power spectral magnitude limit values should meet the following limits.

- $PSD_{CM\_LA\_TX\_CRPAT}$ is greater than zero
- $PSD_{CM\_SA\_TX\_CRPAT}$ is greater than zero
- $PSD_{CM\_LA\_TX\_CJTPAT}$ is greater than zero
- $PSD_{CM\_SA\_TX\_CJTPAT}$ is greater than zero

Measurement Algorithm

This test is yet to be implemented.
**HS-TX Transmitter Frequency Offset (f\textsubscript{OFFSET\_TX})**

The purpose of this test to verify that the Frequency Offset (f\textsubscript{OFFSET\_TX}) of the DUT HS-TX transmitter is within the conformance limits.

In this test, the HS-TX Transmitter Frequency Offset of the DUT will be measured while the DUT is driving a CRPAT test pattern into the R\textsubscript{REF\_RT} reference load, using the Large Amplitude. The nominal frequency will be measured using a constant-frequency (i.e., linear fit) CDR, which will be used to recover a reference clock from the data stream. The recovered UI value will be converted to the f\textsubscript{OFFSET\_TX} result in ppm, where,

\[
\text{f}_{\text{OFFSET\_TX}} = \frac{1}{2 \cdot \text{UI}} - \frac{f_{\text{HS}}}{f_{\text{HS}} / 1E6}
\]

**Test References**

See Section 1.1.15 in version 0.65 of the *M-PHY Physical Layer Conformance Test Suite*, and Section 5.1.2.10 of the *M-PHY Specification 1.00*.

**PASS Condition**

The frequency offset values should meet the following limits.

- f\textsubscript{OFFSET\_G1A\_TX} is between –2000 ppm and +2000 ppm
- f\textsubscript{OFFSET\_G1B\_TX} is between –2000 ppm and +2000 ppm

**Measurement Algorithm**

1. Select the desired test based on HS-Gear, Termination mode, and Amplitude mode.
2. Configure the DUT to transmit a test pattern with either Large Amplitude or Small Amplitude as desired.
3. The scope will trigger on the test pattern burst.
4. The scope will produce the differential of TXDP and TXDN.
5. The scope will determine the data rate using the CDR\textsubscript{RATE} query.
6. The f\textsubscript{OFFSET\_TX} will be calculated based on the formula above.
3 TX Signalling and Timing Electrical Tests
This section describes the Agilent Infiniium digital storage oscilloscope calibration procedures.

**Required Equipment for Oscilloscope Calibration**

To calibrate the Infiniium oscilloscope in preparation for running the DDR3 automated tests, you need the following equipment:

- Keyboard, qty = 1, (provided with the Agilent Infiniium oscilloscope).
- Mouse, qty = 1, (provided with the Agilent Infiniium oscilloscope).
- Precision 3.5 mm BNC to SMA male adapter, Agilent p/n 54855-67604, qty = 2 (provided with the Agilent Infiniium oscilloscope).
- Calibration cable (provided with the Agilent Infiniium oscilloscopes). Use a good quality 50 Ω BNC cable.
Calibrating the Infiniium Oscilloscope and Probe

Internal Calibration

This will perform an internal diagnostic and calibration cycle for the oscilloscope. For the Agilent oscilloscope, this is referred to as Calibration. This Calibration will take about 20 minutes. Perform the following steps:

1. Set up the oscilloscope with the following steps:
   a. Connect the keyboard, mouse, and power cord to the rear of the oscilloscope.
   b. Plug in the power cord.
   c. Turn on the oscilloscope by pressing the power button located on the lower left of the front panel.
   d. Allow the oscilloscope to warm up at least 30 minutes prior to starting the calibration procedure in step 3 below.

Figure 6  Accessories Provided with the Agilent Infiniium Oscilloscope

- BNC Shorting Cap (Used to calibrate 54850A series oscilloscopes)
- Precision 3.5 mm Adapters (2)
- Calibration Cable (Used to calibrate 54850A, Agilent Infiniium oscilloscopes)
2 Locate and prepare the accessories that will be required for the internal calibration:
   a Locate the BNC shorting cap.
   b Locate the calibration cable.
   c Locate the two Agilent precision SMA/BNC adapters.
   d Attach one SMA adapter to the other end of the calibration cable — hand tighten snugly.
   e Attach another SMA adapter to the other end of the calibration cable — hand tighten snugly.

3 Referring to Figure 7 below, perform the following steps:
   a Click the **Utilities**>**Calibration** menu to open the Calibration dialog box.

![Figure 7 Accessing the Calibration Menu](image)

4 Referring to Figure 8 below, perform the following steps to start the calibration:
   b Uncheck the Cal Memory Protect checkbox.
   c Click the Start button to begin the calibration.
During the calibration of channel 1, if you are prompted to perform a Time Scale Calibration, as shown in Figure 9 below.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Calibration Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Passed</td>
</tr>
<tr>
<td>2</td>
<td>Passed</td>
</tr>
<tr>
<td>3</td>
<td>Passed</td>
</tr>
<tr>
<td>4</td>
<td>Passed</td>
</tr>
<tr>
<td>Aux</td>
<td>Passed</td>
</tr>
</tbody>
</table>

**Figure 8** Oscilloscope Calibration Window
Calibrating the Infiniium Oscilloscope and Probe

Figure 9  Time Scale Calibration Dialog box

e  Click the Std+Dflt button to continue the calibration, using the Factory default calibration factors.

f  When the calibration procedure is complete, you will be prompted with a Calibration Complete message window. Click the OK button to close this window.

g  Confirm that the Vertical and Trigger Calibration Status for all Channels passed.

h  Click the Close button to close the calibration window.

i  The internal calibration is completed.

j  Read the NOTE below.

These steps do not need to be performed every time a test is run. However, if the ambient temperature changes more than 5 degrees Celsius from the calibration temperature, this calibration should be performed again. The delta between the calibration temperature and the present operating temperature is shown in the Utilities>Calibration menu.

Required Equipment for Probe Calibration

Before performing the MIPI M-PHY tests you should calibrate the probes. Calibration of the solder-in probe heads consists of a vertical calibration and a skew calibration. The vertical calibration should be performed before the skew calibration. Both calibrations should be performed for best probe measurement performance.

The calibration procedure requires the following parts.

- BNC (male) to SMA (male) adapter
- Deskew fixture
- 50 Ω SMA terminator
Probe Calibration

Connecting the Probe for Calibration

For the following procedure, refer to Figure 10 below.

1. Connect BNC (male) to SMA (male) adapter to the deskew fixture on the connector closest to the yellow pincher.

2. Connect the 50 Ω SMA terminator to the connector farthest from the yellow pincher.

3. Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium oscilloscope.

4. Connect the probe to an oscilloscope channel.

5. To minimize the wear and tear on the probe head, it should be placed on a support to relieve the strain on the probe head cables.

6. Push down the back side of the yellow pincher. Insert the probe head resistor lead underneath the center of the yellow pincher and over the center conductor of the deskew fixture. The negative probe head resistor lead or ground lead must be underneath the yellow pincher and over one of the outside copper conductors (ground) of the deskew fixture. Make sure that the probe head is approximately perpendicular to the deskew fixture.

7. Release the yellow pincher.
Figure 10  Solder-in Probe Head Calibration Connection Example
Verifying the Connection

1. On the Infiniium oscilloscope, press the autoscale button on the front panel.
2. Set the volts per division to 100 mV/div.
3. Set the horizontal scale to 1.00 ns/div.
4. Set the horizontal position to approximately 3 ns. You should see a waveform similar to that in Figure 11 below.

![Figure 11: Good Connection Waveform Example](image)

If you see a waveform similar to that of Figure 12 below, then you have a bad connection and should check all of your probe connections.
Figure 12  Bad Connection Waveform Example
Running the Probe Calibration and Deskew

1. On the Infiniium oscilloscope in the Setup menu, select the channel connected to the probe, as shown in Figure 13.

![Figure 13](image)

Figure 13  Channel Setup Window.

2. In the Channel Setup dialog box, select the Probes... button, as shown in Figure 14.
3 In the Probe Setup dialog box, select the Calibrate Probe... button.

4 In the Probe Calibration dialog box, select the Calibrated Atten/Offset radio button.
5 Select the Start Atten/Offset Calibration... button and follow the on-screen instructions for the vertical calibration procedure.

![Probe Calibration Window](image)

**Figure 16**  Probe Calibration Window.

6 Once the vertical calibration has successfully completed, select the Calibrated Skew... button.

7 Select the Start Skew Calibration... button and follow the on-screen instructions for the skew calibration.

At the end of each calibration, the oscilloscope will prompt you if the calibration was or was not successful.

**Verifying the Probe Calibration**

If you have successfully calibrated the probe, it is not necessary to perform this verification. However, if you want to verify that the probe was properly calibrated, the following procedure will help you verify the calibration.

The calibration procedure requires the following parts:
- BNC (male) to SMA (male) adapter
- SMA (male) to BNC (female) adapter
- BNC (male) to BNC (male) 12-inch cable such as the Agilent 8120-1838
For the following procedure, refer to Figure 17.

1. Connect BNC (male) to SMA (male) adapter to the deskew fixture on the connector closest to the yellow pincher.
2. Connect the SMA (male) to BNC (female) to the connector farthest from the yellow pincher.
3. Connect the BNC (male) to BNC (male) cable to the BNC connector on the deskew fixture to one of the unused oscilloscope channels. For infinium oscilloscopes with bandwidths of 6 GHz and greater, use the 54855-61620 calibration cable and the two 54855-64604 precision 3.5 mm adapters.
4. Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium oscilloscope.
5. Connect the probe to an oscilloscope channel.
6. To minimize the wear and tear on the probe head, it should be placed on a support to relieve the strain on the probe head cables.
7. Push down on the back side of the yellow pincher. Insert the probe head resistor lead underneath the center of the yellow pincher and over the center conductor of the deskew fixture. The negative probe head resistor lead or ground lead must be underneath the yellow pincher and over one of the outside copper conductors (ground) of the deskew fixture. Make sure that the probe head is approximately perpendicular to the deskew fixture.
8. Release the yellow pincher.
9. On the oscilloscope, press the autoscale button on the front panel.
10. Select Setup menu and choose the channel connected to the BNC cable from the pull-down menu.
11. Select the Probes... button.
12. Select the Configure Probe System button.
13. Select User Defined Probe from the pull-down menu.
14. Select the Calibrate Probe... button.
15. Select the Calibrated Skew radio button.
16. Once the skew calibration is completed, close all dialog boxes.
Figure 17  Probe Calibration Verification Connection Example
17 Select the Start Skew Calibration... button and follow the on-screen instructions.

18 Set the vertical scale for the displayed channels to 100 mV/div.

19 Set the horizontal range to 1.00 ns/div.

20 Set the horizontal position to approximately 3 ns.

21 Change the vertical position knobs of both channels until the waveforms overlap each other.

22 Select the Setup menu choose Acquisition... from the pull-down menu.

23 In the Acquisition Setup dialog box enable averaging. When you close the dialog box, you should see waveforms similar to that in Figure 18.

![Figure 18 Calibration Probe Waveform Example](image)

**NOTE** Each probe is calibrated with the oscilloscope channel to which it is connected. Do not switch probes between channels or other oscilloscopes, or it will be necessary to calibrate them again. It is recommended that the probes be labeled with the channel on which they were calibrated.
4 Calibrating the Infiniium Oscilloscope and Probe
Figure 19  1134A InfiniiMax Probe Amplifier

Agilent recommends 116xA or 113xA probe amplifiers, which range from 3.5 GHz to 12 GHz.

Agilent also recommends the E2677A differential solder-in probe head. Other probe head options include N5381A InfiniiMax II 12 GHz differential solder-in probe head, N5425A InfiniiMax ZIF probe head and N5426A ZIF Tips.
InfiniiMax Probing

Figure 20  E2677A / N5381A Differential Solder-in Probe Head

Table 9  Probe Head Characteristics (with 1134A probe amplifier)

<table>
<thead>
<tr>
<th>Probe Head</th>
<th>Model Number</th>
<th>Differential Measurement (BW, input C, input R)</th>
<th>Single-Ended Measurement (BW, input C, input R)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Differential Solder-in</td>
<td>E2677A</td>
<td>7 GHz, 0.27 pF, 50 kOhm</td>
<td>7 GHz, 0.44 pF, 25 kOhm</td>
</tr>
</tbody>
</table>

Used with 1168A or 1169A probe amplifier, the E2677A differential solder-in probe head provides 10 GHz and 12 GHz bandwidth respectively.